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Light Detectives     (Student Guide) 
Using NASA’s WISE Data to Identify Brown Dwarfs and ULIRGs 
 

 
 

Figure 1: An artist's rendition comparing 
stars, brown dwarfs, and planets to the same 
size scale. From left to right is the limb of the 

Sun, a very low mass star, a pair of brown 
dwarfs, and the planet Jupiter. These objects 
have masses ranging from 1000 times that of 
Jupiter (for the Sun) through 75, 65, 30, and 

1 Jupiter mass, respectively. 
 

 
If you have ever looked at the sky through a telescope on a dark night, stars were not 
the only celestial bodies within your field of view. Space is filled not only with stars, 
but planets, asteroids, giant clouds of dust and gas (nebulae), white dwarfs, brown 
dwarfs, and entire galaxies. Astronomers are able to distinguish between objects and 
learn about their properties by the observing and analyzing the light they emit.   
 
Every type of light, or electromagnetic radiation, is associated with a wavelength and 
energy. The characteristics of the light emitted by an astronomical body can provide 
clues about things like its composition, temperature, size, mass, and how it interacts 
with its environment.1 The goal of NASA’s WISE mission is to take a detailed look at 
space in infrared light. In this activity, you will learn to identify a class of objects that 
have very distinct features when observed in this part of the electromagnetic 
spectrum: brown dwarfs. In the Going Further section, you will extend this knowledge 
to look for another type of object: Ultra-Luminous Infrared Galaxies (ULIRGs). 
 
Brown Dwarfs 
A brown dwarf is an astronomical object that, when it was formed, did not quite have 
the mass necessary to become a star.  On the inside of stars that are similar in size or 
bigger than the Sun, hydrogen atoms join together and 
become helium, releasing energy in the process; hydrogen is 
the “fuel” that causes stars to shine.  This process is called 
nuclear fusion.  In brown dwarfs, fusion also occurs, but 
lithium and deuterium act as the fuel, not hydrogen. 

 
For most brown dwarfs, fusion does not last for long.  After a brown dwarf stops 
fusion and cools down, it generates energy only through gravitational contraction. The 
masses of brown dwarfs range from about 13 times the mass of Jupiter to about 80 
times the mass of Jupiter. Objects less massive than 13 times the mass of Jupiter 
would be classified as giant planets; objects more massive than 80 times the mass of 
Jupiter probably fuse hydrogen and would be called stars. Brown dwarfs are one kind 
of object that the new WISE mission is searching for. 
  
                                                 
1 Visit the following website for a lesson on the nature of light: http://mwmw.gsfc.nasa.gov/  

http://mwmw.gsfc.nasa.gov/
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Procedure: 
Explore: Finding and downloading the data (images) 
 

1. Go to the WISE Image Service: http://irsa.ipac.caltech.edu/applications/wise 
Here is what the home screen looks like: 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
2. In the “Single Objects” tab, type the following coordinates into the space 

following “Name or Position”: 
 

04h23m33s -04d15m53.5s Equ J2000 
 

This is the location of the field in which you will search for Brown Dwarfs. 
 

3. Where it says “Return Image Size (leave blank for full images)”,  
• first, select the “Arc Minutes” option from the pull-down menu.   
• then enter 23 into the box (this is the size of the field you will search). 
 

4. Leave the other default items selected and click the “Search” button. 
 

5. On the next page you will see a variety of images on the left and bottom, as 
well as four green rows with a lot of numbers (if you want to learn more about these 
images, as well as how to get other infrared images from WISE then click here2).  To download 
the image data, check the boxes next to the first three green rows, then click 
the “Prepare Download” button.   
 
 
 
 
 
 
 

6. This brings up a dialog box (see below).   
a. For “Download All Bands (1-4)” select “No”.   

                                                 
2 http://wise.ssl.berkeley.edu/edu_accessing_images.html 

http://irsa.ipac.caltech.edu/applications/wise
http://wise.ssl.berkeley.edu/edu_accessing_images.html
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b. For “Zip File Structure” select “Flattened (no folders)”.  
c. Unclick the box “Send me email with URLs to download”  
d. Leave the other items as they are and click “Prepare Download.” 

 
 
 
 
 
 
 
 
 
 
 
 

7. Once the download is complete, it should prompt you to save a file (if not, click 
on the link in the top right corner, then Download Now). Save 
the data file “WISE_Files.zip” to a location on the computer that you will be able 
to access (such as the desktop).3 4 

 
 
 

Congrats! You have just downloaded real 
data (images) from a NASA space 

telescope! 
 

This is the exact same data that 
astronomers are using. 

 
 
 
 
  

                                                 
3 Extracting the data from the Zip file may require special software on your computer depending on your 
operating system. Some operating systems come with software built in to extract files from Zip files. 
Others may not. In those cases you can find free programs online to do the trick: For Windows try 7-Zip, 
For Mac try StuffIt Expander. 
4 The images that come from the WISE archive are in the FITS format [Flexible Image Transport System]. 
FITS is the most common format used in astronomy because FITS files can provide much more 
scientifically valuable information than other, more common, image file formats like JPEG, TIFF, PNG, and 
GIF. However, the most commonly used image processing software programs, such as Adobe Photoshop, 
typically don’t recognize these FITS files, which is why we are using SalsaJ. 

http://download.cnet.com/7-Zip/3000-2250_4-10045185.html?tag=mncol;1
http://download.cnet.com/StuffIt-Expander/3000-2250_4-10653042.html?tag=mncol;2
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Light Detectives     (Student Guide) 
Using NASA’s WISE Data to Identify Brown Dwarfs and ULIRGs 
 
 
Searching for Brown Dwarfs Using SalsaJ  

 
 

 
 

1. Open Salsa J5 on your computer. (Note: these instructions and screenshots are 
for version 2.2 of SalsaJ. Other versions will function and appear slightly 
different but are still able to complete the same tasks.) 
 

 
 
 
 
 

 

                                                 
5 SalsaJ for all computers can be downloaded here:  
http://www.euhou.net/index.php/salsaj-software-mainmenu-9/download-mainmenu-10 

http://www.euhou.net/index.php/salsaj-software-mainmenu-9/download-mainmenu-10
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2. Go to the File menu (or click on the picture of the folder in the upper left-hand 
corner) and open the three unzipped images you just downloaded. Dragging 
and dropping the unzipped files into the SalsaJ toolbar also works.  The first 
image will have -w1- in the middle of its file name. This is the WISE image 
taken in the W1 (3.4 μm) band.  Let’s look at this one first.   
 

3. Compare the image to the finder chart and make sure you can see all of the 
objects that are labeled on the finder chart. If you can’t see them, go to Image 
> Adjust > Brightness/Contrast. This will bring up a new window. Click on the 
“Auto” button to see more objects (or try moving the Maximum setting lower). 
Once you can see all of the objects numbered in the finder chart, close the 
“Brightness & Contrast” window. 

 
4. Now we’ll set up the tool we’re going to use to measure the brightness of the 

objects in the image. Click on the Analyze > Photometry Settings.  In the pop-
up window input the following settings: 
 

o Coordinates of Star’s Center: Auto  
o Star Radius: Forced Star Radius = 10  
o Sky: Forced Sky Radius = 20  

 
The settings are saved if you close the “Photometry Settings” window after. 

 
5. We’re ready to start measuring the brightness. Go to Analyze > Photometry. 

This will create a new empty pop-up window, called Photometry.  
 
 
 
 
 
 
 
6. When you put the mouse over the -w1- image, a cross will appear.  Use the 

finder chart to locate object #1 and click on it. You should see the first row of 
the Photometry window now contain some new data. 

 
7. Copy the following numbers onto your data table: 

 
x, y, Star’s intensity 

 
Put the intensity under the “W1 [DN]” column (only the digits before the 
decimal point). 

 
The first two numbers, x and y, are the location of the object. The third 
number, the intensity in units of digital numbers (DN), tells you how much 
light is coming from the object. 
 

8. Measure the rest of the finder chart objects in order in this same way. If you 
mess up, just highlight the erroneous row in the data table and choose Edit -> 
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Cut. Stop when you get to object #12, and make sure you’ve put the right 
numbers in the right places in your data table. 

 
 

9. Open the next image: the -w2- image (in 4.6 μm). It is important you identify 
the same stars in the image. The finder chart and the star’s location (x, y) can 
help you with this (the x or y coordinates may drift by a number or two 
between the different images, but no more than two). For each of the stars you 
measured before, measure the same star again in the new image and add that 
data to the table. This new data goes in the next column labeled W2 [DN].   

 
10. Repeat for the third image: -w3- (in 12 μm). It is important you identify the 

same objects in the same order (objects #4, #6 and #8 are especially tricky in 
the -w3- image). 

 
 
 

 
Plotting the Color-Color Diagram 
 
1. Astronomers can distinguish brown dwarfs from other objects by comparing 

their intensities in different wavelengths. You’ll be doing this same thing, by 
computing the ratios of intensities between the three images (wavelengths) you 
just measured.  This means that for each object, you should divide the W2 
intensity by the by the W1 intensity. Also take W3 and divide by W2.  These 
values can be recorded in the last two columns of the table.  Keep in mind that 
ratios may be less than 1.  
 

2. For each object, plot W3/W2 on the x-axis and plot the corresponding value of 
W2/W1 on the y-axis. This plot is called a color-color diagram.  Brown dwarfs 
can be identified by the location these points occupy on the plot.   
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Data Table for Brown Dwarf Search: 
TABLE 1 

Brown Dwarf 
Finder 
chart # X Y W1 [DN] W2 [DN] W3 [DN] W2 / W1 W3 / W2 

1        

2        

3        

4        

5        

6        

7        

8        

9        

10        

11        

12        

 
Color-color Diagram for Brown Dwarf Search: 
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Light Detectives     (Student Worksheet) 
Using WISE Data to Identify Brown Dwarfs and ULIRGs 
 
 
 
 
1. Photometry:   
In this activity, you measured the amount of light coming from each star in the finder 
chart.  This is called photometry.  Explain why the images you open on your computer 
(W1, W2, and W3) look slightly different from one another.  In other words, why do 
you measure three different numbers (W1, W2, and W3) for the same star? 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
 
2. Helpful clues for a light detective. Part 1:   
Brown dwarfs are expected to emit less W1 (3.4 μm) light than normal stars, so they 
have lower values of W1.  But this is not enough to tell you whether an object is a 
brown dwarf or not.  Why?  (Hint: The objects in the finder chart are at different 
distances.  Do you expect W1 to increase or decrease as an object moves farther 
away?) 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
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3. Helpful clues for a light detective. Part 2:   
Brown dwarfs are expected to have higher W2/W1 ratios than normal stars, but this is 
still not enough information to tell you whether or not an object is a brown dwarf.  
Why not?  Why do you also need to know the ratio W3/W2?  (Hint: Remember the 
color-color diagram in the slide show [Slide #11] that included galaxies, ULIRGS, and 
AGB stars) 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
 
4. A WISE detective: 
The wavelength of light at which an object shines most brightly depends on how hot 
that object is.  If you know the object’s temperature (T), you can find that 
wavelength, using this equation:  
 

wavelength = 2900
𝑇

 
 

(a) The surface temperature of a brown dwarf is about 1000 degrees Kelvin 
(1000 K).  Use the equation to calculate the corresponding wavelength of 
light.  Your answer will be in units of μm (microns). 

 
 
 
 
 
 
 
 
 

(b) The temperature at the surface of the Sun is about 5800 K.   What is the 
corresponding wavelength? 
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5. Why Infrared?: 
The human eye can see light having wavelengths between 0.39 μm and 0.7 μm.  
Explain why we cannot see brown dwarfs with the naked eye, and why a telescope like 
WISE can help us to detect brown dwarfs. 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
  
__________________________________________________________________ 
 

 
************************************************ 
 
 
 
 
 
Going Further: ULIRGS  
 
An Ultra-Luminous Infrared Galaxy (ULIRG) is a type of galaxy that is a 100 times 
more luminous in infrared light than it is in visible light. The key to this excess of 
infrared light is dust, which mostly emits infrared light and which astronomers observe 
wherever stars are forming. Thus, ULIRGs may be found in merging galaxies whose 
collisions lead to dust-enshrouded bursts of star formation. WISE will discover ULIRGs 
all over the sky. 
 
Observing an object in different wavelengths of light helps astronomers to more fully 
understand that object’s properties.  The various physical and chemical interactions 
taking place in and around a star, for instance, produce different wavelengths of light; 
so the star looks different depending on the wavelength in which it is observed.   
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1. Follow the exact same instructions as above in the brown dwarf activity (pages 

2 - 3) to download three new images from the WISE Image Service. However, 
this time enter the following coordinates:  

06:20:54, -63:18:10 Equ J2000 
 
Finding ULIRGs 
 

The Finder Chart below (also on slide #14) contains the list of the targets you’ll 
measure. The numbers are arbitrary. The same targets appear in each of the 
three images you’ll analyze. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Use SalsaJ and follow the same steps as you did in the brown dwarf activity 
(pages 3 – 5) to measure the brightness (intensity) of each of the objects in all 
three images. The only difference is to use these Photometry Settings instead: 

o Coordinates of Star’s Center: Auto  
o Star Radius: Forced Star Radius = 7  
o Sky: Forced Sky Radius = 15  

 
Note: As before, it is important you identify the correct objects in the same 
order  
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Data Table for ULIRG Search: 
TABLE 2 

Ultra-Luminous Infrared Galaxy (ULIRG) 
Finder 
chart # X Y W1 [DN] W2 [DN] W3 [DN] W2 / W1 W3 / W2 

1        

2        

3        

4        

5        

6        

7        

8        

9        

10        

11        

12        

 
Color-color Diagram for ULIRG Search: 
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Verifying it’s a ULIRG with the Hubble Space Telescope 
 

You now probably have a very good idea about which object is likely to be a 
ULIRG. But what if it’s not even a galaxy? What if it’s just a strange type of 
star? If we could zoom in on the object and see some sort of structure, like 
maybe a spiral arm, that sure would help us verify that it’s a galaxy. 
 
The WISE telescope doesn’t have high enough resolution to do this, but 
thankfully there’s another great telescope that does. The Hubble Space 
Telescope can provide just the kind of high-resolution close-up image that 
we’re looking for… 

 
3. Search for this same part of the sky in the Hubble archives by going to the 

website, http://archive.stsci.edu, and entering the same coordinates as in step 
#1 (without “Equ J2000”): 
 

06:20:54, -63:18:10 
 
Leave the other options at their defaults and click “Search.” 
 

4. You are taken to a web page containing all the GALEX6 and Hubble Space 
Telescope (HST) images taken in that region of the sky. Scroll down to the HST 
sections (HST: NICMOS-IMAGE and HST:WFPC2) and click on the links in the 
tables under the Dataset columns to explore the images. 
 
Do any of them show an object that looks like a galaxy? Do you see anything 
that might be a spiral arm? 
 
…If so then you have discovered your first ULIRG! 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

                                                 
6 http://www.galex.caltech.edu/about/overview.html 

http://archive.stsci.edu/
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Light Detectives        (Student Worksheet continued...) 
Using WISE Data to Identify Brown Dwarfs and ULIRGs 
 
 
 
 
6. ULIRGs: 
Why are ULIRGs to the right of brown dwarfs in the color-color diagram? 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
___________________________________________________________________ 
 
_________________________________________________________________ 
 
__________________________________________________________________ 
 
7. ULIRGs: 
Why does the ULIRG look different in the WISE images compared to the in Hubble 
Space Telescope images? 

__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
__________________________________________________________________ 
 
____________________________________________________________________ 
 
________________________________________________________________ 
 
__________________________________________________________________ 


